Demo of MLP and UMAP combined on CYTOF-
Panorama samples

Version 1.1, March 2022

This demo teaches how to build a training set (classifier) for AutoGate’s Multi-Layer Perceptron (MLP) with Uniform
Manifold Approximation Method (UMAP), based on the classifications done by the biologists (manual gates) in Cytof
Panoroma'’s published gating strategy - http://cgqworkspace.cytogenie.org/Tutorials/omipB.png

For reference, full publication is available here
https://www.nature.com/articles/nmeth.3863?WT.feed name=subjects haematopoiesis

This document describes how to build a MLP model using the manual gates and then apply the model on other samples.
1 Set up the experiment

1.1 Click “Open AutoGate demo experiment” on the main window
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Start new AutoGate experiment
Open existing AutoGate experiment
Open AutoGate demo experiment
Show GenieWiki

Click to open a pre-packaged demo experiment
Show keagent uenie
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Computer management (Y]

Contact us

Exit AutoGate



AutoGate responds by showing you the below list of demo experiments available as of February 2022

o [ ] 10 available demos...

Select a demo and click the Ok button..
(To see supporting documentation click buttons Publication, Gating or Tutorial)

Basophil Activation Test Publication Tutorial
6 stains by Yael Gamez, Richard B. Moss et al
Macrophages and B cells Publication Gating Tutorial
10 stains by Eliver Ghosn, Leonore Herzenberg et al
Pre-gated Macrophages and B cells Publication Gating Tutorial
10 stains by Eliver Ghosn, Leonore Herzenberg et al
© CYTOF Panorama data set Publication Gating Tutorial
49 stains by Nikolay Samusik, Garry P Nolan et al
]
- OMIP-069: Forty-Color Full Spectrum Flow Publication Gating Tutorial
‘ 40 stains by Lily M. Park et al@Cytek Biosciences Inc.
‘ CyTOF Quantitative Comparison Publication Gating
50 stains by William E. O'Gorman et al@Genentech Inc.
OMIP-047: Hi-D Phenotypic Characterization of B Cells Publication Gating
16 stains by Thomas Liechti, et al.
OMIP-044: 28-Color Immunophenotyping Human Dendritic Publication Gating
28 stains by Florian Mair & Martin Priic
Comparison of CyTOF assays across sites Publication Gating
22 stains by Michael D. Leipold, Holden T. Maecker et al
OMIP-044 with EPP: 28-Color Immunophenotyping Human Dendritic Publication Gating

28 stains by Florian Mair & Martin Priic

¥ Cancel -

1.2 Pick CytoF Panorama data set

AutoGate responds by opening the GatingTree window on the publication’s fully stained samples. The bundled demo has

already completed the setup plus the replication of the published manual gating (indicated by ) hierarchy for one sample
and being applied (indicated by ) on rest of the samples.



@ [C] GatingTree (AG v5.1.21b+):
File Hi-D Edit Search View Preferences Window
S, HFoaABe+~EHmEeE T | ¥ 25%

BM2_cct_normalized_01_non-Neutrophils.fcs { ‘Manual gates

2 All samples

(22 Stain set #1
23] BM2_cct_normalized_01_non-Neutrophils.fcs <86,864 events> |1

( I::_"‘ Manual gates<g6,864/86,864 100%> L1

N non-Neutrophils<71,929/86,864 83%> |
N Eosinophils<4,917/71,929 6.8%> I
.N Non-Eosinophils<66,321/71,929 92%> 1
Cl .F.’ Plasma Cells<118/66,321 0.18%> I
C I:I non-Plasma Cells<66,096/66,321 99.66%> |,
BE BM2_cct_normalized_02_non-Neutrophils.fcs <87,772 events> A
¢ Ez‘h Manual gates<87,772/87,772 100%> A
W non-Neutrophils<75,453/87,772 86%> A
W Eosinophils<4,991/75,453 6.6%> A
FI Non-Eosinophils<69,998/75,453 93%> A

B BM2_cct_normalized_03_non-Neutrophils.fcs <84,556 events> A
2] BM2_cct_normalized_04_non-Neutrophils.fcs <80,713 events> A
2] BM2_cct_normalized_05_non-Neutrophils.fcs <84,610 events> A

¢ :F:'h Manual gates<g4,610/84,610 100%>

Note: If you have already opened the panorama dataset and changed the GatingTree, you can start
again using Reset analysis to original demo from the File menu

00 GatingTree (AG
W Hi-D Edit Search View Preferen

Create new folder 3#N
Export data+gates to file(s) T ¥F

Reset analysis to original demo



2 Build a training set(classifier) in supervised classification mode for both UMAP

and MLP, based on the classifications (manual gates) done by the experts.

2.1 Click Hi-D from the menu and then MLP neural network under Configure/train

‘o0 @ GatingTree (AG v5.07.21b):

File BEPW Edit Search View Preferences Window

#° B Classify/predict T 1l W
MLP neural network L

BM2_ Epp (Exhaustive Projection Pursuit) X®E | Omanuarg
EPP explanation

&4 Configure/train

pS  MLP neural network

UMAP parameter reduction 38U
MDS & Hi-D match XOaM »
Phenograms Qp  4events> B

2.2 AutoGate responds by bringing up the following MLP configuration screen.

@ Train MLP on "Manual gates"

Train on gating sequence's

\\>. Leaf gates only

Z

\ / o Leaf or last
branch gates

r Specify reagents/p (29)...
Pick using 43y or or O *

rMLP code base

© Python's TensorFlow
Epochs limit: 500

MATLAB's fitcnet

Add to the training 0/9

other related gates See in UMAP

Concel (D



Note:

1) Python is required to run TensorFlow on the computer, which can be downloaded here -
https://www.python.org/downloads/

2) To use MATLAB'’s fitcnet code base, it is required that AutoGate is run on Matlab R2021a or later version. To
download, click here - htips://au.mathworks.com/products/compiler/matlab-runtime.html This tutorial is
documented on Matlab R2021b

MLP code base

Iteration limit: 1250
Python's TensorFlow

© MATLAB's fitcnet % hold out o5
for validating

Add to the training 0/9

other related gates See in UMAP

Cancel (D

2.3 Specify the parameter for MLP to train on

To effectively build a training set based on the published manual results for a specific sub hierarchy we need to
identify both the parameters that

1. Were used for the manual analysis
2. Those that look informative for the same cell types



2.4 Click on the tree icon to point MLP at parameters used for Manual gates

@ Train MLP on "Manual gates"

Train on gating sequence's

7 \\” Leaf gates only
| 7 © Lesfortast
branch gates
Specify (29)...

Pick using

Eea X

MLP code base _ " ra
Pick reagents from GatingTree

Iteration limit: 1250
Python's TensorFlow

© MATLAB fitcnet % hold out
25
for
Add to the training 0/9
other related gates See in UMAP

Concel (D

2.4.1 Pick Manual gates of the first sample in the gating tree and click Pick

eoce GatingTree for associated reagents picking...

v 5
QEnter GatingTree search terms. » 2

1 Next T Prev S

All samples

1 Stain set #1
B8 BM2_cct_normalized_01_non-Neutrophils.fcs <gs g6 events» .
<> &%k Manual gates-ss sosras.as4 100%> L1
J2 non-Neutrophils <71 a29res 6 g% [
| 2 Eosinophils<s.17/71,929 6 82> L1
4> 2 Non-Eosinophils<s 321171.925 o2%> [
O 7 Piasma Calls<11e/66,321 0.1 [I1
> I non-Plasma Cells<cs.096160,521 99.60%- I
O A pDCs-<s.136/66,090 4.7%> 11
It

non-pDCs.
62,19165,096

=) BM2_cct_normalized_02_non-Neutrophils.fcs <67,772 events> Y
> 83 Manual gates<a7,772187,772 100> 1o

J non-Neutrophils<7s 45387772 863 |4

| T Eosinophils < so1/7s.453 6 6% 4.

4> A1 Non-Eosinophils<es seas 453 a3 |4
B8 BM2_cct_normalized_03_non-Neutrophils.fcs <s4 556 events> .
88 BM2_cct_normalized_04_non-Neutrophils. fcs <60,713 events> .
B8 BM2_cot_nomalized_05_non-Neutrophils.fcs <6610 events> 1.
B3 BM2_cct_normalized_06_non-Neutrophils fcs <77,262 events>
B8 BM2_cot_nomalized_07_non-Neutrophils.fcs <os067 events> 1.

% Cancel -



AutoGate returns to the configuration window. The parameters can also be specified using the Reagent
Table.

[ ) Train MLP on "Manual gates"

Train on gating sequence's

.%.%. \ Leaf gates only

N7

[ ) e o Leaf or last
branch gates

Specify reagents/parameters (29)...
’VPIck using I or | or O *

’rMLP code base

Pick from ReagentTable = weighing more

of the reagents' KLD and distribution etc.
Pvthon's TancarFlaw 1 1

Click the table icon (highlighted above) to choose from the Reagent Table

[ ] [ ] ReagentTable BM2_cct_normalized_01_non-Neutrophils.fcs

Marker II:I:'S 1 | Zﬂi:::;l::l;mnem | Median | Stain/fluorophor Mean ds:;;:::
CD23 17 [ ] -0 (Nd146)Di 0 2
Foxp3 165 il 0 (Gd158)Di 1 2
TCRgd 1.05 11 0 (Dy162)Di 0 1
DNA2 0.99 111 . 111 (Ir193)Di 133 85
120g8 0.97 [ I -0 (Nd150)Di 4 22
CcD11c 0.95 I | 0 (Nd142)Di 1 5
CcD103 0.94 I 0 (Yb173)Di 0 1
IgD 0.86 [ 0 (Pr141)Di 5 16
cps 0.86 | -0 (Eu151)Di 2 16
CD44 084 NN NN 105  (Lu175)Di 126 15
TCRb 0.84 1 0 (Tm169)Di 2 11
beadDist 0.77 | B 30 beadDist 28 7
BC6 0.74 m 2 (Pd110)Di 3 4
BC3 0.73 Il E. 196 (Pd105)Di 212 101
BC1 0.72 [ W | 204 (Pd102)Di 220 109
BCS 0.68 [l | 4 (Pd108)Di 5 5
CD16_32 068 NN I N 47  (Gd156)Di 70 83
cD19 0.66 [ [ N 0 (Sm149)Di 2 4
NKp46 0.65 T MWl -0 (Nd145)Di 1 2
CcD138 0.62 1 [ 0 (Yb172)Di 1 2
BC2 0.6 HE . 161 (Pd104)Di 174 85
FceR1a 0.58 T 11 0 (Dy161)Di 1 3
CCR7 0.57 1T NN 1 0 (Dy163)Di 1 12
Cell_length 0.57 il 22 Cell_length 23 6
cD27 0.47 1 I 1 (Gd155)Di 7 22

"Max scale": is the upper limit as recorded in the FCS file

All (29/50) ¥ Cancel ./ Pick (29)



2.5 Select the sample (to add to the training model) by clicking Add to the training other
related gates button

r MLP code base

Iteration limit: 1250
Python's TensorFlow

© MATLAB's fitcnet % hold out 25
for validating

Add to the training 0/9

other related gates See in UMAP

Build MLP model including other gates ...
T Cancel T

26 Select BM2_cct_normalized_07_non-Neutrophils.fcs sample

@ @® Confirm ...
Select extra gates to train on
Al (1/9) Sort: frequency 2L

BM2_cct_normalized_07_non-Neutrophils.fcs

(;. @ Manual gates
- 95,087/95,087
ID=825 GatingTree-> 100%
View->Refresh

BM2_cct_normalized_02_non-Neutrophils.fcs
( Manual gates
87,772/87,772

ID=676 GatingTree-> 100%
View->Refresh

BM2_cct_ d_08_non phils.fcs
(). Manual gates
d‘:‘ﬁ 85,741/85,741

ID=833 GatingTree-> 100%

View->Refresh

BM2_cct_nomalized_05_non-Neutrophils.fcs

C' Manual gates
Lt 84,610/84,610
10=809""% GatingTree> 100%

View->Refresh

*_ Cancel -




AutoGate indicates the number of samples added (1/9). Ensure settings for Iteration limit and % hold out
for validation are as below.

Select See in UMAP check box
O Train MLP on "Manual gates"

- Train on gating sequence's —

Leaf gates only

o Leaf or last
branch gates

r Specify reagents/parameters (29)...
Pick using i'!'i or or O b4

r MLP code base

Iteration limit: 1250
Python's TensorFlow

O MATLAB's fitcnet % hold out 25
for validating

Train on 1/9 other

related gates See in UMAP

Cancel (QETEEND

2.7 Click Train



2.8 Review settings

0@ Visualizing MLP with UMAP...
Your current basic UMAP settings are:
Nearest neighbors: 20

Minimum distance:  0.3000
Continue with these basic settings?

© Yes ... and show progress.
Yes ... without showing progress.

No ... open ParameterReduction window to
configure advanced settings.

¥ Cancel -

Click OK when ready.

2.9 Save the template

UMAP template (closes in 8...

B Tr
Specify UMAP template —| /.nVy.\
‘ole.
@/

b E \o'e’
Clo R sec \.’ i
Specify UMAP template
Save As: panorama_S‘IS7_usl|
Tags:
v = mip A Q
Format:  (*fes_) &

Cancel Save



2.10 Click OK to the overlap alert

Stand by... .
6%> I

Training MLP neural network vents> A

Collecting events in 23 leaf gates

5 secs remaining

§
() o Gates overlap...

New overlap ratio is 0.2%, and old ratio
was 0.2% ...is 0.2% acceptable ???

") No, try to improve overlap
O Yes 0.2% overlap is OK

Remember for
this subset ¥ Cancel -

2.11 MLP and UMAP Training in progress. Takes ~couple of mins.

[ NN J Parameter reduction...

B OOF Name save v sync Cluster dtl 4

rﬁ_neighbors=20, min_dist=0.3, metric=euclidean,randomize=1, Iabels=3$7

MATLAB's fitcnet is training an MLP neural network...

Up to a maximum of 1250 iterations

100 L5 iepoizg 22l 4020k, A’ ‘)“’ with 25% held for validation for 136,464 x 29 values in:
8 [ <pesktop>
{% / [ AutoGateDemoExperiments
i ] Panorama.txt.autoGate
@ mip
—* panorama_S1S7.mip_ust.fcs

0%

Running UMAP on 178k x 29, MEX
(optimize_layout method=MEX)

Time spent-




2.12 UMAP and MLP completed.

$Ro

o

UMAP-Y 29D—2D

o Name Save v Sync.:.'..:‘

<>

Cluster detail none

UMAP-X 29D—2D

~ 1 Show Geniewiki w

Show Reagent Genie
Cloud Apps (powered by G
Computer management

Your computer info

H non-;

Dl AL

F

B BM2_cct_normal
B BM2_cct_normal

[ ) @® Legend: UMAP 27 clusters/37 supervisors ...

A
All (32/32) | sort by
v . -
.- Classical Monocytes "9 15%  16% 27,707
® 5 cells Frac, F {raining 14%  14% 24,559
New subset #1 2 raining  9.1% 15,897
v . - % o
@ ® on-mbcs (non specific) 7ining 8% B.T% 15,215
B cells Frac. E @ning 6.3% 7% 12,168
J . .= ﬂn ) o
. Intermediate Monocytes training 6.2% 6.4% 11,102
Eosinophils training 5.7% 5.9% 10,313
New subset #2 2 raining 4% 7,016

ini 0, 0,
.pDCS training 3.3% 3.3% 5,831

*B cells Frac A.C aining 11% 2.5% 4,303

Deselecting hides items in plot & selecting unhides

N Regions of interest

As we have now a model, it can be applied on other samples.



3 Apply the Model

3.1 Select the manual gates of BM2_cct_normalized _02_non_neutrophils.fcs to apply
the model.

[ ION ] GatingTree (AG v5.1.21b+):
File Hi-D Edit Search View Preferences Window
Frh,Heral@-~Cbmen T | W 5%

BM2_cct | ized_02_ ils fe Cmanual gates

@‘5 2 All samples
&b
Stain set #1
BE BM2_cct_normalized_01_non-Neutrophils.fcs <86,864 events> It
¢ a8 Manual gates<s6,864/86,864 100%> IIL
N non-Neutrophils<71,929/86,864 83%> I
(| N Eosinophils<4,917/71,929 6.8%> [}
4> 51 Non-Eosinophils<s6,321/71,920 929> I,
| H Plasma Cells<118/66,321 0.18%> .
¢ I non-Plasma Cells<66,096/66 321 99 66%> '
B BM2_cct_normalized_02_non-Neutrophils.fcs <67,772 events> 4.
(|£:'h Manual gates<s7,772/87,772 100%> B|

N non-Neutrophils<75,453/87,772 86%> la
| A Eosinophils<« 99175 453 6.6%> 1
{?7 W Non-Eosinophils<69,998/75,453 93%> la

3.2 Click Hi-D > MLP neural network under Classify/Predict

Edit Search View Preferences Windo

Classify/predict

EPP (Exhaustive Projection Pursuit) \HE
EPP explanation

Configure/train

MLP neural network 3L
UMAP parameter reduction {8U
MDS & Hi-D match X{4M

Phenograms oP |



3.3 Ensure configuration is as below

Uncheck Only match (to have the gates created in the gating tree) and By overlap checkboxes
o @ MLP classifying...

Classify via an MLP neural network

MLP denotes "multilayer perceptron"
...deep leaming based on feedforward
fully connected neural networks

L v
Use fitcnet
oeoe o
o .‘5. ® Use TensorFlow
‘." .. (Python must be installed)
23 prior gates
’r Only match By overlap

f«:rast:gygz:mer ¥ Cancel -
Click Classify 0/9 other related gates button to select the samples that need the model applied.

Select gates for _05 and _08 samples and click OK



@ @ Confirm ...
Select extra gates to classify
Al 2/9) Sort: frequency EI )

BM2_cct_nomalized_07_non-Neutrophils.fcs

‘:‘ Manual gates
95,087/95,087

ID=825 GatingTree-> 100%
View->Refresh

BM2_cct_nomalized_01_non-Neutrophils.fcs

{;‘ Manual gates
o 86,864/86,864

ID=594 GatingTree-> 100%
View->Refresh

BM2_cct_normalized_08_non-Neutrophils.fcs

‘; Manual gates
85,741/85,741

ID=833 GatingTree-> 100%
View->Refresh

BM2_cct_normalized_05_non-Neutrophils.fcs

v \ Manual gates
9 ¢ 4 84,610/84,610

ID=809 GatingTree-> 100%
View->Refresh

. Cancel -

Confirmation that 2/9 gates are selected. Click OK to run

[ J @ MLP classifying...

Classify via an MLP neural network

MLP denotes "multilayer perceptron"
...deep leaming based on feedforward
fully connected neural networks

L g )
4 © Use fitcnet
o .f. ®
o0 0 Use TensorFlow
9'e (Python must be installed)

23 prior gates
’V Only match By overlap

Classify 2/9 other
related gates * Cancel -




3.4 Specify the model (filename.umap.mat)

Prompts to select the model. Specify the model that was saved earlier.

Note... (closes in 10 secs)

e Hirz' IER (2@ Q Search Documentation
Open MLP model 3
*mlp.mat (fitcnet)...

D Edit Search View Preferences Window
s HrARO-~O M BT

i‘ormalized_OZ_non-NeutrophiIs.fcs 4.

mv =|v 2 mip 8 Q

L

#.| panorama_S..._ust.mlp.mat

& panorama_S...st.umap.mat

# | panorama_S...cs.umap.mat

% panorama_S1S7.mlp.mat panorama_S1S7_ust.umap.mat

MATLAB Data - 148.6 MB
Information
Created Today at 12:03 am

Options Cancel m

Classifying the samples using the model is quick (~ 20 secs in this example)



3.5 MLP classifications completed

Notice that the selected three samples (_02, 05 and _08) are now classified. Check the MLP
classifications gates available for these samples. Highlighted below are for _02 and _05 samples

[ ] [ ) GatingTree (AG v5.1.21b+):
File Hi-D Edit Search View Preferences Window L]

Frh, oA~ HmEdE T | W 25% 5y

BM2_cct_normalized_05_non-Neutrophilsfes 4’y p. Manual gates ID=309 (panorama_s157_ust)

= All samples

b
(22 Stain set #1
B BM2_cct_normalized_01_non-Neutrophils.fcs <86,864 events> 11
(’ Ez'h Manual gates<ss,864/86,864 100%> 1
BE BM2_cct_normalized_02_non-Neutrophils.fcs <87,772 events> A
(* Ez'h Manual gates<87,772/87,772 100%> A
{4 f:‘h MLP: Manual gates ID=676 (panorama_S1S7_ust)<87,772/87,772 100%>
BE BM2_cct_normalized_03_non-Neutrophils.fcs <84,556 events> A
B BM2_cct_normalized_04_non-Neutrophils.fcs <80,713 events> A
B BM2_cct_normalized_05_non-Neutrophils.fcs <84,610 events> A
4> &% Manual gates<s4,610/84,610 100%> £

{i‘ [{z‘ﬁ MLP: Manual gates ID=809 (panorama_S1S7_ust)<84,610/84,610 100%>

@ non-Neutrophils (non specific)<548/84,610 0.65%>
@ Eosinophils<4,923/84,610 5.8%>

@ Non-Eosinophils (non specific)<145/84,610 0.17%>
@ Plasma Cells<492/84,610 0.58%>

@' non-Plasma Cells (non specific)<3,164/84,610 3.7%>
@' pDCs<2,615/84,610 3.1%>

@ CD3-- CD49b+ (non specific)<1,531/84,610 1.8%>
@ NK cells<540/84,610 0.64%>

@ Basophils<473/84,610 0.56%>

#5 cD3+ CD49b- (non specific)<e07/84,610 1.1%>
@ gd T cells<54/84,610 0.06%>

@ ab T cells (non specific)<277/84,610 0.33%>

@ CD4 T cells<950/84,610 1.1%>

@ CD8 T cells<1,351/84,610 1.6%>

@ CD3- CD49b~- (non specific)<5/84,610 0.006%>

L &."—@ mDCs<197/84 6100 237
LI

= Edit plot



MLP classifications for _08 sample

([ ) @ GatingTree (AG v5.1.21b+):
File Hi-D Edit Search View Preferences Window 3

Frh s, HoaBR@-~ESbwman t | ¥ 259 @

BM2_cct_normalized_08_non-Neutrophils.fcs

I

{/‘MLP: Manual gates ID=833 (panorama_S1S7_ust)

BE BM2_cct_normalized_06_non-Neutrophils.fcs <77,282 events> A

BE BM2_cct_normalized_07_non-Neutrophils.fcs <95,087 events> A
¢ i‘:‘h Manual gates<95,087/95,087 100%> £

BE BM2_cct_normalized_08_non-Neutrophils.fcs <85,741 events> A

(" E:'h Manual gates<ss,741/85,741 100%> A

<

5:'5 MLP: Manual gates ID=833 (panorama_S1S7_ust)<85,741/85,741 100%>

@ non-Neutrophils (non specific)<489/85,741 0.57%>
@' Eosinophils<5,692/85,741 6.6%>

@' Non-Eosinophils (non specific)<115/85,741 0.13%>
@ Plasma Cells<38/85,741 0.04%>

@' non-Plasma Cells (non specific)<3,332/85,741 3.9%>
@ pDCs<2,948/85,741 3.4%>

@' CD3-- CD49b+ (non specific)<1,443/85,741 1.7%>
@ NK cells<308/85,741 0.36%>

@' Basophils<436/85,741 0.51%>

@ CD3+ CD49b- (non specific)<1,093/85,741 1.3%>
@ gd T cells<58/85,741 0.07%>

@' ab T cells (non specific)<313/85,741 0.37%>

@ CD4 T cells<855/85,741 1%>

@' CD8 T cells<1,912/85,741 2.2%>

@ CD3- CD49b~ (non specific)<6/85,741 0.007%>
@' mDCs<120/85,741 0.14%>

@ non-mDCs (non specific)<9,330/85,741 11%>

@' Macrophages<600/85,741 0.7%>

@ Lin-cKit+ Sca1- (non specific)<468/85,741 0.55%>
@ MEP<970/85,741 1.1%>

@' GMP<1,035/85,741 1.2%>

@ CMP<309/85,741 0.36%>
=

= Edit plot



4 Checking the classification using MDS

1) We have trained MLP + UMAP combined on two samples and applied that model on two separate
samples. To compare between the expert (Manual) gates and MLP+UMAP gates using
MultiDimensional (MDS) scaling, select both the gates at the top level or any subset of interest.

[ ] ® GatingTree (AG v5.1.21b+):
File Hi-D Edit Search View Preferences Window
Frhy,HoaR@ -~ Mhmen T | ® 25%

@
BM2_cct_normalized_02_non-Neutrophils.fcs

@g All samples

[ Stain set #1
BE BM2_cct_normalized_01_non-Neutrophils.fcs <6,864 events> (I

Cp: Manual gates 1D=676 (panorama S1S7 ust)

< gb% Manual gates<s6,864/86,864 100%> !
B BM2_cct_normalized_02_non-Neutrophils.fcs <87,772 events>

{[{Eﬁ Manual gates<s7,772/87,772 100%> 14 ‘

A non-Neutrophils<75,453/87,772 86%> |
{:‘ .fh MLP: Manual gates ID=676 (panorama_S1S7_ust)<87,772/87,772 100%>
@ non-Neutrophils (non specific)<458/87,772 0.52%>

@ Eosinophils<4,998/87,772 5.7%>

and click Hi-D > Multidimensional scaling

[ ] ([ ] GatingTree (AG v5.1.21b+):
File MgIE®M Edit Search View Preferences Windo
#° B Classify/predict

MLP neural network L
@2 EPP(Exhaustive Projection Pursuit) ~ \%E
———  EPP explanation
;,(i Configure/train
MLP neural network 8L
UMAP parameter reduction 38U
MDS & Hi-D match X4M
Phenograms XoP |
Visualize |
UMAP parameter reduction Bl
Phenogram(s) XP.
MDS & phenogram(s)

Heat map XE |



2) Brings up the MDS/Hi-D match window with Manual gates on the left and MLP gates on the right

;é lkfvcfﬁinﬂﬁn‘z)o@@l Names:  Use legend

MDS2 29D—2D

23 subsets, BM2_cct_normalized_02_non-Neutrophils.fcs
in 87,772 events of "BM2_cct_normalized_02_non-Neutrophils.fcs "
(Manual gates)

MDS/Hi-D match (AG v5.2.21b+): 29D, best "QFxF matches", 22 bins):

¥4 Predictions

e e o o o o e @

B cells Frac. F F=98.8%, 17%,
Classical Monocytes F=98%, 14%,
8 cells Frac. E F=97%, 7.3%,
Eosinophils F=98.7%,5.1%,
Intermediate Monocytes F=96%, 4.8
pDCs F=98%, 3%,

8 cells Frac. D F=96%, 2.1%,
CD8 T cells F=98%, 1.9%,

GMP F=90%, 1.6%,

8 cells Frac AC F=83%,1.5%,
MEP F=92%,1.1%,

CD4 T cells F=95%, 0.9%,

Non classical monocytes F=95%, 0.9
Macrophages F=91%, 0.5%,
Basophlls F=93%, 0.5%,

CMP F=82%, 0.5%

NK cells F=89%, 0.4%,

MPP F=87%,0.3%,

mDCs F=86%, 0.2%,

CLP F=67%,0.2%,

Plasma Cells F=95%, 0.2%,

gd T cells F=81%, 0.1%,

HSC F=51%, <0.1%,

|f.C: Phenograms >>

36 subsets (13U"mached]’ Bry ot normalized_02_non-Neutrophils.fcs
in 87,772 events of "BM2_cct_normalized_02_non-Neutrophils.fcs "
(MLP: Mana gate ID=876 (panorama, 157 st)

L L |

9 Parameter reduction

-08

-06

-04

<02 0 0.2
MDS1 29D-:2D

.
Readings: J MDs & phenograms (QF tree)

=}

e O

o

0O o0 e O

o

e o e o

e« + o e e e e 0O

B cells Frac. F F=98.6%, 17%,
Classical Monocytes F=98%, 14%
non-mDCs (non specific) 8.6%,

8 cells Frac. E F=97%, 7.5%,
Eosinophls F=98.7%,5.7%,
Intermediate Monocytes F=96%, ¢
non-Plasma Cells (non specific) 3
pDCs F=98%, 3.1%,

B cells Frac. D F=96%, 2.1%,
Monocytes (non specific) 2%,
CD8 T cells F=98%, 1.9%,

GMP F=90%, 1.8%,

D3~ CD4b+ (non specific) 1.7%
B cells Frac A-C F=88%, 1.5%,

B cels (non specific) 1.2%,

CD3+ CDA49b- (non specifc) 1.2%
MEP F=92%,1.2%,

Non classical monocytes F=95%,
CD4 T cells F=95%, 0.9%,

8-cell Frac D-F (pro-B cells) (non s
Macrophages F=91%, 0.5%,
non-Neutrophils (non specifc) 0.5
Basophils F=93%, 0.5%,
Lin-cKit+ Scai- (non specific) 0.5%
CMP F=82%, 0.5%,

NK cells F=89%, 0.4%,

Lin cKit- Scat+ (non specific) 0.4%
ab T cells (non specific) 0.4%,
MPP F=87%,0.3%,

mDCs F=86%, 0.2%,

Plasma Cells F=95%, 0.2%,

CLP F=67%, 0.2%,
Non-Eosinophis (non specific) 0.1
gd T cells F=81%, 0.1%,

HSC F=51%,<0.1%,

CD3- CD4Sh- (non specific) <01

Time spent for matching: 562 secs



3) For a detailed view, click the table icon from the tool bar

000
~;:3 % -{”C n./|11 .!-:ll- ED i—] f:'i (.D 0 El E , Names: Use legend g

See summary table of matching

Brings up the QF match summary table

[ X X )} Hi-D match (AG v5.2.21b+): 29D, best "QFxF matches", 22 bins):
2 @, BEE B if @ 531 ¢ i MATCH sets: training=all 23 matched, test=23/36 ("* V=)

Rank ! ‘ # ‘ Name ‘ ﬁ'{;'s | 2‘)’2“;:&) ?FY:::ZUN) Plot B ‘ Foq ‘ :voe'nts ?Dm ‘ Omphans ‘ :;’:::s ‘ :‘r:’;\f::
1 @23 Bcells Frac. F 2 99.9% 98.8% 1 16.7% 14,671 755 N/A N/A N/A
1 @59 Bcells Frac. F 2 99.9% 98.8% 2 17% 14,903 2050 N/A N/A N/A
2 1 Eosinophils 2 99.9% 98.7% 1 5.7% 4,991 681 N/A N/A N/A
2 25  Eosinophils 2 99.9% 98.7% 2 5.7% 4,998 2016 N/A N/A N/A
3 o3 pDCs 2 99.8% 98.5% 1 3% 2,677 689 N/A N/A N/A
3 29 pDCs 2 99.8% 98.5% 2 3.1% 2,682 2020 N/A N/A N/A
4 22 Bcells Frac. E 2 99.7% 97.1% 1 7.3% 6,420 754 N/A N/A N/A
4 58 B cells Frac. E 2 99.7% 97.1% 2 7.5% 6,619 2049 N/A N/A N/A
5 o8 CD8 T cells 2 99.6% 98.1% 1 1.9% 1,650 710 N/A N/A N/A
5 37 CD8 T cells 2 99.6% 98.1% 2 1.9% 1,650 2028 N/A N/A N/A
6 17  Classical Monocytes 2 99.6% 98.1% 1 14% 12,245 742 N/IA N/A N/A
6 51 Classical Monocytes 2 99.6% 98.1% 2 13.9% 12,231 2042 N/A N/A N/A
7 2 B cells Frac. D 2 99.5% 95.5% 1 2.1% 1,856 752 N/A N/A N/A
7 57 B cells Frac. D 2 99.5% 95.5% 2 2.1% 1,849 2048 N/A N/A N/A
8 18  Intermediate Monocytes 2 99.5% 95.6% 1 4.8% 4,221 744 N/A N/A N/A
8 52 Intermediate Monocytes 2 99.5% 95.6% 2 4.9% 4,282 2043 N/A N/A N/A
9 .19 Non classical monocytes 2 99.3% 95% 1 0.9% 802 745 N/A N/A N/A
9 58 Non classical monocytes 2 99.3% 95% 2 0.9% 826 2044 N/A N/A N/A

10 o7 CDA4 T cells 2 99.3% 95% 1 0.9% 816 708 N/A N/A N/A
10«38 CD4 T cells 2 99.3% 95% 2 0.9% 813 2027 N/A N/A N/A
1" " MEP 2 98.9% 92.1% 1 1.1% 972 727 N/A N/A N/A
1 .43 MEP 2 98.9% 92.1% 2 1.2% 1,029 2034 N/A N/A N/A
12 .5 Basophils 2 98.8% 93% 1 0.5% 423 701 N/A N/A N/A
12 .3 Basophils 2 98.8% 93% 2 0.5% 431 2023 N/A N/A N/A
13«20 B cells Frac A-C 2 98.7% 88.2% 1 1.5% 1,356 748 N/A N/A N/A
13 55 B cells Frac A-C 2 98.7% 88.2% 2 1.5% 1,296 2046 N/A N/A N/A
14 10 Macrophages 2 98.5% 90.9% 1 0.5% 477 717 N/A N/A N/A
14 M Macrophages 2 98.5% 90.9% 2 0.5% 471 2032 N/A N/A N/A
15 .2 Plasma Cells 2 98.1% 94.6% 1 0.2% 170 685 N/A N/A N/A
15 .27 Plasma Cells 2 98.1% 94.6% 2 0.2% 181 2018 N/A N/A N/A



4) To get the mass+distance similarity score (using QFMatch) and F-measure overlap, click on the
below buttons in the toolbar

fi. a1l

Shows the accuracy level.

% Mass+distance similarity (A"M2°") median/mean=98.8/97.6%

MATCH sets: training=all 23 matched!, test=23/36 (' NEW))

10 |

# of subset matches

0
0

20

Confusion chart

80

100

See false +/- | 95%,

40 60
% mass+distance similarity

"1%
1.1%
1.1%
1.1%
1.1%
1.5%
.5%
1.6%
1.6%
95%

. MATCH sets: training=all 23 matched|, test=23/36 (13NEW)

12

# of subset matches

2 L

0

% Overlap (F-measure)

% Overlap (FMe35Ure) median/mean=93.0/89.7%

10 |

1

L

1

H

Il

0

20

| Confusion chart

40 60
% overlap

80

100

See false +/- |




4.1

4.2

Investigating classification quality in further detail

The median and mean summaries of the test set’s similarity and overlap with a training set classification
is not likely adequate to form conclusions about a particular configuration of MLP/UMAP classifiers.
Thus, additional views are provided.

The toolbar button on the Hi-D match table with label +- allows you to create the other supplementary

visualizations of the classification.

4, MATCH sets: training=all 23 matched!, test=23/36 (13NEW!)

False positive/negative charts

Prediction detail table

Confusion chart

Import false +/- into AutoGate GatingTree

—

Prediction Adjudicator

Click on the Prediction detail table from the above menu to bring up the Prediction Adjudicator table.
This table aids the user in adjudicating whether for each particular class the false negatives
(classifications made only by the biologist () have greater mass+distance similarity to the whole
predicted class than false positives (classifications made only by MLP/UST).



000 PredictionAdjudicator 36 X 66 subsets

S @ = 4 157 €9 False + MORE similar in 2/15 cases
St ) o T e
CD8 T cells false* 77% 32 0% 65 0% false +  2028.2
CD8 T cells false- 83.2% 32 0% 66 3.8% false - 2028.3
CD3- CD49b- (non specific) f!#e - 100% 6 0% 67 100% - false - 2029.3
mDCs e * 96.4% 154 0.2% 68 91.4% -  tue+ 2030.1
mDCs false * 82.3% 20 0% 69 0% false +  2030.2
mDCs false - 80.8% 29 0% 70 27.4% false - 2030.3
non-mDCs (non specific) fa%e - 100% 7,540 9.9% 71 100% e  false- 2031.3
Macrophages ™ * 98.9% 431 0.6% 72 95.6% - true + 2032.1
Macrophages fa!s¢ * 80.5% 46 0.1% 73 0% false +  2032.2
Macrophages %" 88.5% 40 0.1% 74 15.7% false - 2032.3
Lin-cKit+ Sca1- (non specific) fal%e - 100% 430 0.6% 75 100% - false - 2033.3
MEP true+ 98.5% 921 1.2% 76 94.5% -  true+ 2034.1
mep false 80.3% 51 0.1% 77 0% false +  2034.2
MEep false - 86.9% 108 01% 78 19% false - 2034.3
Gmp true+ 97.6% 1,338 1.8% 79 92.6% -  true+ 2035.1
Gmp false* 83.2% 76 0.1% 80 0% false +  2035.2
Gmp false - 84.8% 214 03% 81 24.2% false - 2035.3
cmp false - 100% 402 05% 82 100% -  false- 2036.3
Hsc false - 100% 21 0% 83 100% -  false- 2037.3
mpp false - 100% 301 04% 84 100% -  false- 20383
Lin cKit- Sca1+ (non specific) fdee 100% 320 0.4% 85 100% - false - 2039.3
cLp false- 100% 163 0.2% 86 100% -  false- 2040.3
Monocytes (non specific) falve 100% 1,777 2.3% 87 100% - false - 2041.3
Classical Monocytes fals® - 100% 12,231 16.1% 88 100% @ false- 2042.3
Intermediate Monocytes fase - 100% 4,282 5.6% 89 100% «  false- 2043.3

Non classical monocytes filse 100% 826 1.1% 90 100% - false - 2044.3



4.3 Confusion chart

Chart shows the agreement between two classifications in the diagonal boxes and the other boxes are
the ones with false+/-

[ N N J Confusion chart

B cells (non specific)
B cells Frac A-C

B cells Frac. D

B cells Frac. E

B cells Frac. F

B-cell Frac D-F (pro-B cells) (non specific)
Background -

Basophils

CD3+ CD49b- (non specific)
CD3- CD49b-- (non specific)
CD3-- CD49b+ (non specific)
CD4T cells

CD8T cells

CLP

CMP

Classical Monocytes BN
Eosinophils

GMP

HSC

Intermediate Monocytes

Lin cKit- Scal+ (non specific)
Lin-cKit+ Scai- (non specific)
MEP

MPP

Macrophages

Monocytes (non specific)

NK cells

Non classical monocytes
Non-Eosinophils (non specific)
Plasma Cells

ab T cells (non specific)

gd T cells

mDCs

non-Neutrophils (non specific)

True Class

non-Plasma Cells (non specific)

non-mDCs (non specific)
pDCs

Predicted Class

True Class = Biologist classification, Predicted Class = MLP classification



5 Visualize gates in Parameter Reduction / Plot Editor

1) To view a MLP gate, double click the gate. Say Ok to open the gate in Parameter Reduction window

4 5:1, MLP: Manual gates ID=676 (panorama_S1S7_ust)<g7,772/87,772 100%> ‘

@ non-Neutrophils (non specific)<458/¢ @ () MLP gate...
@ Eosinophils<4,998/87,772 5.7%> @

. . 7E "Non-Eosinophils (non
@ Non-Eosinophils (non specific)<sé/8 specific)" is an MLP gate ... thus
@ Plasma Cells<181/87,772 0.21%> SN ED Eho

@' non-Plasma Cells (non specific)<3,2
© UMAP plot in ParameterReduction window

UMAP plot in PlotEditor window
PlotEditor plot for parent cells

@ pDCs<2,682/87,772 3.1%>

#5 CD3- CD49b+ (non specific)<1,506/
@ NK cells<351/87,772 0.4%> PlotEditor plot for these cells
@ Basophils<431/87,772 0.49%>

REMEMBER
#5 cD3+ CD49b- (non specific)<1.032/8 o o X Cancel (HOKID
= S

The above prompt is only shown if Preferences is set to Ask if gate is MLP+UMAP (as shown below)

FEEENGESE Window ¥ Styles Dictate Editor

See PlotEditor preferences 8P
Don't suggest PlotEditor axes

Hide Modeled/Applied gate icons (. [ [ [A)

Show modeled gate next to applied (‘=)

Hide modeled gate next to UNapplied (/4)

Show plot's parent gate title

Show logicle review question for new experiments
Sample groups...

Sample names...

Double clicking on a gate opens a... »

PlotEditor opens on the gate's... » Parent cells
New gate names »  Child (gated) cells
Gate frequency labeling »  Child cells if parent is organizer

Show count 42531 as |l Vv Ask if gate is MLP+UMAP



2) Opens the gate in Parameter Reduction window

[ ) @ ParameterReduction (AG v5.1.21b+): BM2_cct_normalized_02_non-Neutr... !

L@ eho e o
v All (37/37) EE sonby v
R
v .B cells Frac. F 177 14903
Show clusters? 20
medium 15 ® nsupervised 4% 12273
Contours 10 v .
@ 5 Classical Monocytes 1% 12291
a o
& % 7,540
> B non-mDCs (non specific) 8.6%7,
|
o -10
< 7.5% 6,619
% -15 B cells Frac. E "™ ™
20
-25 Eosinophils 5.7% 4,998
<0 " — V' “Intermediate Monocytes 9% #2682
15 10 5 0 5 10 15 Yy
UMAP_X 29D-2D 3
= ’ V' non-Plasma Cells (non specific) >6% 3202
v e 3.1% 2,682
em wpemapy oy e o T PR
selecting hides items in plot & selecting unhides
Review/undo remembe @ CD3- CD49%b-- (I 9 p 9
ion i mDCs<183/87,77 See MLP gate
RN @ = in PlotEditor m r's

Check for update @' non-mDCs (non

Select the subsets to have it reflected in the Parameter Reduction window, as below.



[ ] [ ] Subsets that supervised UMAP

ljl sort by s )

Al (2/37)

7% 14,903

MLP: Manual gates ID=676 ... 7772 ° 1
87,772 cells X 29 dim., 23 cluster(s) B cells Frac. F

V' Show clusters? 2
14% 12,273

: [ ]
medium T 15 unsupervised

Contours &
14% 12,231

Classical Monocytes

non-mDCs (non specific) 8.6% 7,540

B cells Frac. E 5% 667

UMAP_Y 29D-»2D

Eosinophils B.T% 4906

4.9% 4,282

45 10 5 0 10 15 Intermediate Monocytes

5
BMAFLA 280520 non-Plasma Cells (non specific) 3.6% 3,202

’pDCs 3.1% 2,682

Re-run &9 Use

@ mDCs<183/87,772 0.21%> Deselecting hides items in plot & selecting unhides

@’ non-mDCs (non specific)<7,540/87,772 & See MLP gate “ @
@' Macrophages<471/87,772 0.54%> g ML=

B A .

3) To view the gate in Plot Editor window, select the gate and click on the MLP icon highlighted below

[ ] @ Subsets that supervised UMAP

All (1/37) EE sort by

.B cells Frac. F 7% 14903

o
.unsupervwsed 14% 12,273

Classical Monocytes 14% 12,231

o
non-mDCs (non specific) 8.6% 7.540

B cells Frac. E /5% 667

o
Eosinophils kb

Intermediate Monocytes 4k 28

o
non-Plasma Cells (non specific) it

*pDCs 3.1% 2,682

Deselecting hides items in plot & selecting unhides




4) Opens in Plot Editor window

[ ] @ PlotEditor (AG v5.1.21b+): BM2_cct_normalized_02_non...
SAE PO+ S Recenaes juf
FEFEp 5@  onouses ‘M ih s v ¢ »

Plot 3 has 14,903 events 14k (98.8%) events are clustered

LX Preferences

(14,903/87,772 17% )
B gells Frac. F ',

10%A L

-
ow

=
5}
N

.
o»—l

%/ | 4 TCRgd:(Dy162)Di

0 \
T T |
0 10t 10? 10° 10*

-J\ FceR1a:(Dy161)Di ¥

mSTUn T g weS

5) Here on, you can continue with gating operations as before (e.g, to change the X/Y parameters, click
on the Reagent table (highlighted above) and set in the table.

eoe ReagentTable BM2_cct_normalized_02_non-Neutrophils.fcs
D O Awaysreesh < (1 @ @csve @ ) @ 1a903xs0  O° Mirror PlotEditor (@ Scatter | & Bl P IO AF+ © Recentaxes ¢ W
Marker oty “ Measurement | Msdisn‘ Sls\nlmomphor‘ Mean ‘ SI[FEL @ onowses 3 EMm T oV 7
DNAZ 094 . 71 (r93)i 77 Plot 3 has 14,903 events 14k (95.6%) events are custored 23 Preforonces
cps 094 . | 0 (Eui51)Di 4
TCRgd 092 NN | -0 (Dy162)Di 0 B cells Frac, F ([4903/87.77217%)
MHCII 092 T W | 442 (YbA76)Di 568 10% ! t
BC5 0.86 1 | 1 (Pd108)Di 2
TCRb 086 T | 0 (Tm169)Di 0
BC4 084 W] | 116 (Pd106)Di 122
BC1 083 I 127 (Pd102)Di 133 103
120g8 083 1 0 (Nd150)Di 4
beadDist 078 m 20 beadDist 20 =}
B220 077 . 135 (Tb159)Di 147 g
cD452 071 . 17 (in115)Di 19 ) 102
cD103 064 T | 0 (Yb173)Di 1 <© kS
Cell_length 064 1] 20 Cell_length 21 %
BC2 061 N . 100 (Pd104)Di 105 L
cp138 059 - 0 (Yb172)Di 1 b
CD44 057 N 6 (Lu175)Di 8 >
NKp46 057 ] 0 (Nd145)Di 1 101
Ccbtie 057 1 0 (Nd142)Di 1 y
IgM 055 O 71 (Yb174)Di 11
CCR7 049 | - 0 (Dy163)Di 1 :
FeeR1a 045 . 1 (Dy161)Di 1 o o T e
DNA1 043 - 34 (I191)Di 38
| FceR1a:(Dy161)Di ¥
250 ‘Max scale": is the upper limit as recorded in the FCS file Kicose (SERND



